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Training Outline

Purpose of Report

User Roles

System Improvements
Logging On and Registration

Data Entry
— Solid Waste Management
— Printing and Finalizing Data

Welcome to the training

You are welcome to leave the training after your relevant section has been discussed.

However, the Bureau and Office Central Office and HQ users should listen to the entire
presentation

The B/O Central Office user session will follow this one



Presenters




LoUmCRDT . A —

;* Gﬂmm Fie View Hep =Rl

The GoToWebinar Attendee View

- -
Use Telephone

X = uie
- C
ﬁ e iy Audio Mode: 2, 1¢e Mic & Speakers
}g : &:i 4 MUTED LTI
L E—

"W \s Sales Solutions

M Driving Up Sales - i

[s] = | Presenter:

/|
quesion for staf] -
Audio: Use your microphone and speakers (ValP) ar call in using your telephane. - -

United States: 1323 417 4600
Access Code: 250-611-T83
Ao P 79

List Additional Confaeence Call

| Start Holding your Own Wed Events with
GoToWebinar

| ERe el A e an

Before we get started, | want to review a few housekeeping items and let you know how
you can participate in today’s Web event.

We’re looking at an example of the GoToWebinar Attendee Interface which is made up of
two parts. The Viewer Window on the left, which allows you to see everything the Presenter
will share on their screen, and the Control Panel at the right. Within that Control Panel is
how you can participate in today’s event, so let’s look at that.

(Transition to Next Slide)



How to Participate Today
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=) Questions 5) *  We will not be using the “raise your

=l hand” feature

[Enter a question for stalf]

Q&A addressed at the end of each
section of the presentation
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Start Holding your Own Web Events with
GoToWebinar
Webinar ID: 977-124-241

GoToWebinar™

Move mouse over the Grab Tab

Clicks 1,2, and 3
By clicking the orange arrow, you can open and close your control Panel

Click 4
From the View Menu you can also set the Control Panel not to auto-hide when inactive if you prefer to keep it always open.

Click 5

The Audio pane provides audio information. (If the organizer has given attendees a choice) By default you have joined the Webinar via
Mic & Speakers.

Click 6
Click Audio Setup to select your computer speaker or headset devices.

Clicks 4,5 and 6

If you prefer, you can join the audio via telephone by selecting Use Telephone, and the dial-in information will be displayed, including an
Audio PIN. If you would like to ask any questions of today’s presenters over the phone, you must enter your Audio PIN in order to have
your line unmuted.

Click 7

During (at the end, etc.) the presentation, you have the ability to send questions to our Webinar staff through the Questions pane. Simply
type in your question and click send. (Optional) At the end of the presentation we will do a Q&A session to answer as many questions as
we have time for.

Click 8

During the presentation we may ask you to answer a question by raising your hand. This option is located on the Grab Tab. (Optional)
You can also indicate that you have a question and would like your line unmuted by raising your hand.

Click 9 and 10

We will address Q&A at the end of today’s session, and as a final reminder, today’s Webinar is being recorded, and everyone will receive
an email within 24 hours with a link to view a recording of today’s event.



Training Norms

*All of the phone lines are muted.

* Please submit questions through the
“Questions” area.

*\We will respond to questions at the end of
each training section.

«You may leave the training after the sections
relevant to your work have been discussed.

-However, the Bureau and Office Central and HQ users should listen to the entire
presentation.

-The Bureau and Office Central Office users training session will follow this one.



PURPOSE OF REPORT

Katie Chiang

Environmental Protection Specialist
Environmental Management Integration Team
Office of Environmental Policy and Compliance




Management and Budget and the Council on
Environmental Quality

— Annual update for the DOI Strategic Sustainability Performance
Plan

— Annual DOI Greenhouse Gas Inventory

* Questions address:

— Executive Order 13514 - Federal Leadership in
Environmental, Energy, and Economic Performance

» Solid Waste and Chemicals Management
— Resource Conservation and Recovery Act
— Pollution Prevention Act of 1990




The Process

How is your data used?

Analysis'\"""'--..,.

by OMB
& CEQ

' N
DOI Strategic Y
Sustainability
S Performance
/ ~ Plan and
~ Greenhouse
Gas Inventory

The data input from Field Users are compiled in the Bureau-wide Report. The Bureau and
Office Reports are then used to develop the updated Department’s Strategic Sustainability
Performance Plan (SSPP) and the Greenhouse Gas Inventory. The SSPP is submitted to the
Office of Management and Budget (OMB) and the Council on Environmental Quality (CEQ).
If you are not familiar with them, but OMB and CEQ are part of the Executive Office of the
President.



Sustainable Practices Database
* The Sustainable Practices Database is
located at http://www.nbc.gov/spreport/

 Field User questions are a subset of the
OMB data call

» 16 solid waste questions

» Data entry should take 1 hour or less if
data is readily available

10

System only includes those questions for which data depend on field
responses

10



USER ROLES

Katie Chiang
Office of Environmental Policy and Compliance

1

11



User Roles

Bureau
HQ
Program
Managers

Program
Managers

12

Here you can see the different layers of users.

12
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More on Roles

M Aantral Mffin AranA _lhna nramira
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contacts in your region, area, or state office.

At each level, there is a “solid waste
manager.”

Central and HQ roles perform data quality
review of field data.

Managers track report status for individual
facilities.

13
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Data Quality Assurance

— Facility User enters data I

[ Faciity User inalizes data and forwards it for review

14
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Status Reports

SUSTAINABLE PRACTICES DATABASE

Status Report for Solid Waste Management

Facility Started Ernail

[+1] 40112

(33 %)
HQ 40012

(33 %)
District Office Email
OEPC Albuquer que Regional Office Ernail
OEPC Anchorage Regional OMice Ernail
OEPC Atlanta Reglonal Office Email
OEPC Boston Regional Office Email &
OEPC Derwer Regilonal Office Emall Sample
OEPC Heatquarters = data only in
OEPC Oakland Ernail th is
OEPC Philadelphia Eml presentation

1
OEPC Partland Email
not actual
Other Ermail
Program Office Email data
15

In the “Reports” tab, Central Office users may track the progress of individual facilities.
Select “Status Report for Solid Waste Prevention & Recycling” from the list of options. The
first column shows the name of the facility. The second column shows whether the facility
has started entering data. The third column shows whether a draft of the data is complete.
The fourth column shows whether that draft has been approved by the Central Office. The
fifth column shows whether HQ has approved the data. If a facility has started its data
entry but it is not complete, the Central Office may email the contacts for that facility to
inquire as to the progress of the facility’s data entry.

**Please Note that all of the data shown in this training are just for demonstration
purposes and are not actual data reported by facilities **

Questions?



SYSTEM HIGHLIGHTS

Katie Chiang
Office of Environmental Policy and Compliance

16
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System Highlights

Data Requested

Navigation

Historical
Reports

User
Registration

17
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navigation [ Feoems

Navigation

Your current
location within the
system is shown

Wanagemarty

BOLID WASTE MANAGEMENT  Facility: OEFC Albuguerque Regional Office

Left A. Salid Waste Prevention

[ waseoisposa

Chemicats

| Fovwara sow vaste oaa |

Click here for [ pmesoovameons |

USEFUL LINKS

yOur bureau ’_ Facity Motes | »
contacts prwcnan |
|

2011 Sobd Wase Data

4

Link to your
2011 data

| g
| 1) b your faciity in leased space?
Tooes and Hazardous T CNe
’ | Ta) 18 your racity space within Your faCIlliy
w::u rx-::umm BCthE DR ProSUCts FECyUing program? name ls
v Cue shown here

Does your facity have housing urits?
T v oNe

¥ appacabie, how mary
NOUSEN0KS POJUCES TECYTANg program?

your taciy have actess o an actve

I uns ot [ ol units

(D your 1Ry i SUOL0E P, SUDSSEN LRy IMOrOved, o updated e
i FY 20127 For on soad o please go o
I et B3, GO £IONT/WaS R/ S0RIWSSENECLCE_waste hitm

T Yex T Mo
It yos, wxplain (255 charactars max):

18

Here, the “Facility Data” tab has been selected.

Within “Facility Data” we are looking at “Solid Waste Management” as indicated towards

the top of the page.

They system has a left-hand side navigation bar, which only lists solid waste management

sections of the report. The current data call does not include a request for green

purchasing data.

The user would complete each item under Solid Waste Management to complete the

report.

Note the following on this page:

-Link to bureau contacts for more information on how to complete this report

-Link to your 2011 Solid Waste Data

18



Notes

USTAINABLE PRACTICES DATABASE

Facility Data Reports Bureau Report Generator Admin  Help Logout

Home » Faciity Data » Sold Waste Management »

SOLID WASTE MANMAGEMENT =~ Facility: OEPC Albugquerque Regional Office

e T Facility Notes
Reoyig aca es:

Waste Disposal ] Add notes 10 ssisiwith preparing Bis reporin B fulure. Fubune wsers Fom your acilly will have actess 1o These notes.

Chermicals Management

Exiterotes

here for next [T

vy [==]
and View Exi sing Note s for this Faciley

notes added Bureau Contacts o naestoind

in previous [ 2ot sobavestcoan |

years

Notices | Disclaimer | Privacy | FOM | USA gov] DO Home | PMB Home

Tt 5 Bk bt 43Tl 1o 1 St Expliser T

19
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Historical Reports

Home Fagcility Data Bureau Report Generater Admin Help

Logout

Solid Waste Reports - Historical Bureau Data

Report only includes data for active faciliies. Previous years' data for facilities that are cumently deactivated are nol included.
Click on the buréau name 1o See the data for the regions

2008 2009 2010

2m
Waste Wasle Recycled  Waste Waste Recycled Waste Waste Recycled  Waste Waste
Recycled (lons) fons) Diversion  (lons) (tons) Diversion  (lons) (tons) Diversion  (lons) {flons) Diversion
Total 11000616718.417 1307542 100% 100,604 182.4484 3554% 48752717 83808845 36.78% 416077 115.188 26.54%
os 1100000044979 13066392 100% 100116 180.49590 3568% 15214178  48.3845 96.91% 0.485 290183 054%

20

Within the “Reports” tab, there are reports with historical data available. This report
compares solid waste data for 2007 through 2010.

To drill down within the bureau, just click on the Bureau name, and on the following screen
click on the Region name. You will then be able to see the facility historical data.



Historical Reports

2010 Reports

Click on the Solid Waste report to print & cogy of solid waste report for that facility
Facility (Region) Solkd VWaste
Office of the Secretary
HO
District Office:

OEPC Albuquergue Regional Office
OEPC Anchorage Regional Office

OEPC Atlanta Regional Office

DOEPC Boston Regional Office

OEPC Denver Regional Office Solid Waste Report
DEPC Headguarters Solid Waste Report
OEPC Oakdand Solid Waste Report

DOEPC Philadelphia Solid Waste Report
DOEPC Portland Solid Waste Report
Other Solid Waste Report
Program Office Solid Waste Report

21

You can also download complete reports for each facility for FYs 2006 - 2011.

21



LOGGING ON

Renu Chaudhry
National Business Center

Logging Into the System
Forgot Username or Password
System Registration

Change Password

Help Resources

22

22



Logging Into the System

Home ContactUs Help Login

Iyou are first time user, please click here to register
Ifyou fargot your user name and/or password, please click here 1o have this information mailed 1o you
To unlock your account, please click here. Request a new password and d will unlock your sccount oo

Please enter your Usemarme and Password below and click the Login® buon
Usermame:
password: |

MIDUSHEOF THIS SYSTEM: This is & United States pubér Systim, b-;ml" of thi Interior, o provide Oficial
only Use of this systern by any authorized or consent . rétrigval, and

ulmwuraw wmmn personnel. Unavihorized use may subject violators to criminal, civil, and for ulsuplmarg acton.

23

To Login and register for the site, go to http://www.nbc.gov/spreport/ and then click on the
“Login” tab to see this screen.

Click “register here” if you are a new user.

Click “forgot your username/password” if you’ve forgotten your password or if you've been
locked out of the system.

If you’ve been locked out of the system due to unsuccessful attempts to login, click on “to
unlock your account”

Only request a password once, it takes up to 5 minutes for you to receive the new
password. Once you receive your new password, copy and paste it directly from the email
into the login page. Be sure to include any punctuation included in the password.

23



SUSTAINABLE PRACTICES DATABASE

ContactUs  Help

Login

Forgot Username / Password
Piease enter your compiete email address and indicate the type of assistance you are requesting, then click the “Submir buion. An email will be sent wilh the
requested information

Ermal Address:

€ Please conflern my Usermame.
€ Please reset my Password
€ Please confiern my Usemname and reset my Password

The password will bie sent 1o you within 5 minues. Ifyou request a new password, please bie sure that you enter it exaclly a5 # appears in the emad that you receie.
“You may want 1o iry copying and pasting the password from the email into the login page, including any punchuation that is included in the password. After you
successiully log in, you are encouraged 1o change your password 1o something you will remernber by going to the "Admin” tab and selecting “Update Password ™

TO USERS OF THIS SYSTEM: This is a United States

P system, the Dn of the Interior, o provide Official
Unclassified L8 Govemment information only. Use of this system by any constitul refrieval, and
by authonzed L use may subject violators to criminal, chwl, and for disciplinary action

Notices | Disclabmer | Privacy | FOIA | USA gov | DOI Home | PMB Home

U.S. Departman

24

This screen appears if you clicked on “Forgot Username/Password” from the Login screen.
Follow the instructions to request information and log in.



System Registration

e SUSTAINABLE PRACTICES DATABASE

4 o
Ay 3.\t

Home ContactUs Help Login

REGISTRATION

Please input your email address to begin registration.

Email Address: |

SUBMIT
VARRNING TO USERS OF THIS SYSTEM: This is a United States Govemment computer system, maintained by the Department of the Interior, to provide Official
Unclassified U.S. Government information only. Use of this system by any ar userc consentio , retrigval, and
disclosure by 1. Unauth use may subject violators to criminal, civil, and for disciplinary action

Motices | Disclaimer | Privacy | FOLA | USA gov | DOl Home | PMB Home

U.S. Dapardmant of the Interior

25

If you clicked on “click here to register” on Login screen, this page will come up. We have
added this step to prevent multiple registrations for the same person. When you enter
your email here the system will check whether you already have an account. If you already
have an account, you will be routed to a page where you can request that your username
or a password be sent to you. If you do not have an account, you will be routed to the
registration page, which is on the following slide.



SUSTAINABLE PRACTICES DATABASE

y  ContactUs Help Legin

Registration

It's important to
pick a password

= Aas i e =
= Contain 0ne Upper-case alpha, one lower-case alpha and one numenc charscler atioliows ese
= Contain ong special characier such a5 @. 5, o & 3 rules |

USER INFORMATION

Please complete the form Below snd click o Subeil bulion. you need help with Bis regiiation process, ok on
froeeed the fallowing criténa

owen: [SoeasBoemr 3]
e Once you pick
B = your bureau and
e, region, you will be
S 4 given a list of
First Name: li .y

facility names to
Last Name: - .
— T pick from here
Phoee Number. -
Password ————
Verify Password -

26

This is the screen that appears when you submit an email address that does not already
have an account. Enter your information into the form to register for the website. Then
click “Submit”



More on Registration

/our email address

e UUser name

e Tl E PRAT T T WS J

(

» Central office program manager will be
notified of new facility user registrations.

* You can register to enter data for more
than one facility.

* |If you move to a new facility, your central
office program manager can update your
user profile with your new contact and
facility info.

27

Generally, your user name is the same as your email address. You may specify a different
user name during the registration process if you like. Please keep a record of that user
name for future reference.



Change Password

Reports Bureau Report Generator dmin Help Logout

Site Administration

Action Hem Description

Update Password This tool allows user to change their password to access the system

Approve Solid Waste This tool allow admin user o approve Solid Waste data of a facility.

Managerment Data

Manage User Accounts This tool allows user o edit or 3dd users 1o the system. Regional / Stabe program leads should revidw users
registered in their jurisdiction o ensure appropriate personnel are accessing the system.

Change User Password This tool allow user 1o change password for existing users.

Manage Facilities List This tool allows user 1o edit or add facilities to the system.

Craate Email Listing This tool allows user 1o create an emall ksting of all the users in region of bureau.

Listing - Facilities and List of contacts associated with facilities

Contacts

Manage Regions List This tool allows user 1o edit or add regions to the system.

Add Motes Add notes to assist with preparing this report in the future. Future users from your region/bureau will have access
to these notes.

Notices | Disclaimer | Privacy | FOIA | USA gov | DOI Home | PMB Home

U5, Dapartmant of the Intesior
Office of Palioy Management and Budget
Last wpdated: Debsbar 23, 2012 28

This site has Bawn splimized for Intamat Explone: 7

If you are able to log into the system, you may change your own password by selecting the
“Admin” tab and then clicking on “Update Password”



Change Password

SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau ReportGenerator Admin Help Logout

Change Password

To update your password, please enler your new password and then confirm it A valid password must meet the following security standards:

» Be atleast 12 characters and no more than 15 characters

» Contain one upp: alpha, one | alpha, and one numeric character

« Contain one special character suchas @, 8, or &

» The new password canl contain the old p (e.g. the old canibe’ and the new p ‘p
Password:

‘Confirm Password:

SAVE

29

If you click on “Update Password” this screen will appear. Simply type your new password
into the fields provided. Then click on “Save” and your password will be changed.



SUSTAINABLE PRACTICES DATABASE

actUs  Help  Login

Department of the Interior FY12 Sustainable Practices Database User Aids

Sustainable Practices Database Field User Training ISES (4 MB)

Sustainable Practices Database Central Office User Training CSEER (4 ME)

Sustainable Practices Database Bureau Headquarters User Training [ (4.3 MB) (=58 (1.8 MB)
o Please view the "Notes™ section of the PowerPoint presentations lnked abave

.

Signed DOI Data Call memo for FY 2012 Reporting on Solid Waste and Chemical Management

Check out
the FAQs

Frequently Asked Questions
Feadback Form

Other useful links:
o Guigance on waste-10-energy and waste diversion

EPA published standard volume to weight corversion factors

Conversion Factors used in this data call

Green procurement links:

o Designated Green Products for Federal Procurement - This Excel documaent outiines the far all 15
note that there are many spreadsheets in this Excel workbook, 0 you may need 10 scroll through them 1o see them all

o EMNERGY STAR

© Federal Energy Management Program (FEMP)

e Electronic Product Environmental Assessment Tool (EPEAT)

o WaterSense

30

If you need help, there are many resources available under the “Help” tab. Some of the

resources are highlighted here.

Training presentations will be added to this page as well.

30



Feedback Form

» Use for all your questions and or
comments.

* Your feedback will automatically be sent to
the DOI contacts (IBC and OEPC) as well
as designated bureau HQ contacts.

Feedback

Please Use This Form To Send Your Guestions or Comments

Name

Email Address
= 31
[ SuUBMIT

Questions?

31



DATA ENTRY

Katie Chiang
Renu Chaudhry

« Solid Waste Questions

* Print Report

«Finalize Data

« Central Office Data Review

32
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PREVIEW OF
SOLID WASTE QUESTIONS

Katie Chiang
Environmental Management Integration Team
Office of Environmental Policy and Compliance

33
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Solid Waste Prevention

Find the name
and contact

information for
your designated
Central Office and
bureau/office HQ
contacts.

SUSTAINABLE PRACTICES DATABASE

Home » Facilty Dats » Sokd Waste Management s

SOLID WASTE MAMAGEMENT | Facility: OEPC Albuquerque Regional Office

s A. Solid Waste Prevention

P chck SV ot o youi ot b s,
‘Waste Disposal 1) Is your facilty in leased space?

CIENEE Morasne 13) 15 your facibty in leased space wihin @ mulktenant bulding?
[ Forvara soka vaste ata | Cves O owe
Re\ﬂew the Data 2)  Does your faciity hive an actie oMce products recycing program?
you submitted = .
for FY11. You

may print the =
| 2011 somwaseData |
FY11 report and

Facilty Motes 3)  Does your faciity have housing units?

- -
Bureau Contacts Yer [ Me

3a) W applicabie, how many resicential housing units operated by your faciity have access to an active
housenold products recyciing program?

[ units of [ Eotal units
refer to it when e
il 4)  Dia your facilty Fne;".j . proved, or upasted nan-Nazard
peevention gractices in FY 20127 For acditional 0n ok waste to
compiiing your hitp iwww £pa. GOV egonTiwaste/sclidwa steireduce_waste him -

FY12 responses.

“ Yes T Ne

It yes, explain (255 characters max):

When you click on the “Facility Data” this is the screen you will see. You can see from the
tabs and menubar that we are in the “Solid Waste Management” section, and the “Solid
Waste Prevention” page.

You can click on the link on the lower left to see your facility’s 2011 data. The data have
been locked and cannot be changed.

The questions shown here are pretty straight-forward, just indicated whether your facility
(1) is in leased space, (2) has a recycling program, (3) has housing units.

34



Solid Waste Prevention (cont'd)

4] Did your faclty instiute new, substantially mproved, or updated T)  Within FY 2012 contracts na\mm faciity, oid ar nciude 3
i FY 20127 For sation on w0 RO Pl (FA8 Clawse 42 243 10) I GETOION, CONSTUCHON, 103 $envice Coriratts th achieve
it i 012 QR EQON TS e SR StETECUCE_waste fim Warste GvErsion goals? Provide SDECAC examples

- -
Yo Mo T ¥es T Mo T MetApplicable

s, axplain (258 characters mask |

5} Does your faciity compost any of &3 waste (ether onsite or offste)? ) VWNaLIs your faCRty's GOSN 10F SOMD Waste ahersion by 20157
SO ks Dirarsan g0 8 50% by 2018
Coves T Mo

Please input only numbers.

"y dalad 9) Do you have onste waste disposal, Such a3 a landfil, 3t your Facilty? Please answer “yes® if your
facity Nas a permtted Landrdl Tat was i1 0Perabon amytime between 1950 and to0ay.

T e T Mo

(R— =1
3] Hyes, how many demoliion progects managed by and/or conduched at your ety IClude the recewsy

e ———"

[ cemcatonproects e[ total demoktion projects in FY 2012 Mobces | Disclaimar | Privacy | FOW | LSAgov| D01 Home | PMB Heme

M w\m-n FY 2012 cwx“rorr:u R A 1m«mt»(weamwem of W
n 1) iR COnSUEiG, 310 S8TACE COMTIS 10 BETuEE
-*me m'mn noals"Dw !pecl\( examoln

T ves T Mo T MotApplicable

Save partially-complete or complete
survey data by clicking on the “SAVE"

button at the bottom of each page
before navigating elsewhere.

If you do not click on “SAVE" your
data will be lost!

35

Note that there are links to hints and helpful information for answering the questions, such
as links to “non-hazardous solid waste prevention practices” and “recovery of construction
materials”

Note that for question #5, the question on composting, re-use of materials onsite such as
mulch or grasscycling in landscaping is not composting. To count as composting, material
must be decomposed in some manner before it is re-applied to landscaping.

For question #9, we are asking whether you have an onsite landfill. If you do, you must
also answer question #9a and provide the amount of waste disposed of ONSITE during FY
2012.

When you are done entering data on this page, click “SAVE” — THIS IS CRITICAL, YOUR DATA
WILL NOT BE SAVED UNTIL YOU CLICK THE “SAVE” BUTTON

35



R I L]
SUSTAINABLE PRACTICES DATABASE
Jureau Repo ene Admin  Help
Home » Facility Data » Solid Waste Management »
SOLID WASTE MANAGEMENT Facility: OEPC Albuquerque Regional Office
I:w e Proventi BE. Recycling
) Recytling Mote: You mast click an “SAVE™ below or your data will be lost.
‘Waste Disposal 1) Indicate which of these commodites your faciity recycled during FY 2012 (10112 - 930/12). Waste
gy may not be counted as recycled.
P T Guidance on waste-to-energy and waste diversion
Chemicals ENEE I Aburniriam I Keyboard
Forward Solid Waste Data F antifreeze I Light Baliasts
USEFUL LINKS [ Batteries (Lead/acid - car) I Mied Paper
o P ok
RECREn [ Batteries (NiCd rechargeabie) I Mewspaper
I™ Batteries - Moed ™ Notebook PC
2011 Solid Waste Data
_ I Brick T pallets
I Car Tres I~ Plastic (#1PET/ZHDPE) Singl
I Cardboard I Priter ieS
Stream
I carpet I Serap Metals
. Category
Co-mmgled I Ceiling tiles I Single-Stream Mixed Recyclabies (steel and includ
category includes - aluminum cans, glass and plastic bollies, mbed Incluaes
1 Co-mingled (ghass Al cans, plastic) paper, cardboard) containers
most containers I Concrete I Stesl Cans and paper
36

Under “Recycling” click on the commaodities that your facility recycled during FY 2012.
Then click “SAVE”.



Recycling (cont’d)

Facility: OEPC Albuquerque Regional Office

B. Racve ling

Note: You must click on “SAVE™ below of your data will be lost.

Please input the actual or estimated weight or volume of the total amount of each commodijdrecycled during FY 2012
your facility. There are volume to weight c onversions programmed info the system for moailis

* EPA published standard volume to weight conversion factors

Select Recycled CED Waste only for items recycled as the result of construction and demolition projects.

+ C8D waste = construction and demolition waste.
« Ton = 2,000 pounds
« Metric Ton = 1,000 kilograms = approcdmately 2,205 pounds

Commodty | Amount Recycled | Unit CompactediNot Type of Recycling

Other | s =] |compacted x| [Select 1=
Select

fareeze |IM oo |Ihs j g.;m?:rgw ‘Waste

R [50.000 [ibs =] M

factors used are

» Conversion Factors used in this data call th rough thege

Conversion

available

links.

Select the Type
of Recycling
here to avoid
receiving an
error later on

37

For each commodity that you selected on the previous page, you will be asked to enter the
amount recycled. You may enter the amounts in a variety of units, as shown here, but they

will be automatically converted to tons for the final report.

You must enter the amount recycled, there are some options for
tons, pounds, cubic yards, etc.

units you can use such as

Under “type of recycling” you must enter whether the recycled waste is recycled
construction and demolition waste (C&D waste), composted, or other recycling. Other

recycling is generally recycled municipal solid waste.

Click “SAVE” when you’ve entered all of your data for the commodities recycled.
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Recycling Data Tips

» Check your units — 100 tons of paper = 200,000
pounds of paper, which is a lot of paper.

» Check estimates of amounts recycled - One
facility reported 200,000 cys paper recycled, this is
equivalent to 75,000,000 pounds. Please do not
over estimate.

* Be careful with decimals and zeros - extra zeros
can greatly increase your recycling amounts.
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Recycling (cont'd)

SUSTAINABLE PRACTICES DATABASE

Reports Bureau Report Generator Admin Help Legout

Home » Facility Data » Solid Wasie Management »

SOLID WASTE MANAGEMENT Facility: OEPC Albuquerque Regional Office

Sohd Vaste Prevention | cer .
| B. Commodities Recycling
I—Rmfw I For FY 2012, your facilty recycled
100 Ibs of Uncompacted Antifreeze - Other Recycling = 100,000 Ibs
| ‘Waste Disposal | 50 Ibs of Uncompacted Manure - Composted = 50,000 Ibs
Totak 150 Ibs = 0.075 tons
Tawics and Hazardous Total Composted Recycling: 50 Ibs = 0.025 tons
Chemicals Tatal C&D 0 Ivs = 0.000 tons
Total Other 100 s = 0.050 ons
| Foward Solls waste Data |

The Recycling data has been saved for this facility
Please proceed fo Sclid Waste Management Waste Disposal (

[ Print Solid Waste Data

USEFUL LINKS

L Faciliity Notes |

| Bureau Contacts |

2011 Solid Waste Data |
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After you’'ve entered information for your commodities recycled, you will see a summary of
the data you entered for those commodities.

After reviewing the data, click on the link to proceed to the “Waste Disposal” section of the
report.



Waste Disposal

ts  Bureau Report Generator Admin  Help Logout

nagement »

All Other Trash (Municipal [too0a0 -
Facility: OEPC Albuquerque Regional Office ‘Solid Waste) sent to Waste. 10,0000 Ibs
to-Eneray

C. Waste Disposal o Total amount of waste sentio

Mot @ You must clck on “SAVE” below of your data will be lost.

cled and was sent

it oy o youi tho ot e iy of thes @ types of waste. 10 & wase--anergy faclily
« Do natinclude C & D waste
Type ofWaste Amount | Urit reported sbove.
# Do notinclude any maberials

Construction and Demolition [fooo00 | [es = ( recytied

‘Waste Sent to Landfil or « Do notinclude frash sentto a
‘Waste-fo Ener gy (CAD Waste) washe incinerator that ks nota
 Total amourt of cONSIUCHoN & wasbe-to aner gy facility

Need help estimating waste amount?

Guidance on waste-to-energy data

Provide commrts here about your waste repored, if amy

tydrosbeciric dams, and habits
restorabon projects

Al Othes Trash (Municipal 100.0000 Ibs 'I(

‘Solid Waste) sent 1o Landfil

= Total amourd of waste 5 ent o
lanaill during FY 12

o Do notinchude C & D waste
repored above.

= Do notinchude any maderials
recycled

= Do notinclude rash sendto 3
war ity.

facility i goes 1o

A8 Other Trash (Municipal 10.0000 Ibs x 40

Soiid Wasiv) seni io Wasie.

In the Waste Disposal section you will be asked about the total amount of waste disposed
and not recycled.

Do not include any amounts recycled on this page.

Report amounts for:

- Construction and demolition waste not recycled

- Municipal solid waste sent to the landfill and not recycled
- Waste sent to waste-to-energy facilities

Click on “Need help estimating waste amount?” if you need assistance.

Also please note that any waste burned for energy is not considered to be diverted waste.
You may still report the amount burned for energy here. Please see the linked Guidance on
Waste-to-Energy Data.
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Waste Disposal (cont’d)

ta Reports Bureau Report Generator Admin  Help Legout
Home » Facility [ata » Sokd Waste Management »

SOLID WASTE MAMAGEMENT  Facility: OEPC Albuquerque Regional Office

= iz C. Waste Disposal
me The Waste Disposal data has been added for this facility
‘Waste Disposal | | category Undiverted Waste fons) Recycled Qons) Dwversion rate

Toodes and Hazarcous e 0005 0.000 0.00%
Chemicals Management

0055 0075 57 69%

Total 008 0075 55.56%

| Forward Solid Waste Data |

PLSOKIWSHEDHD |  Recyiamutonsts
USEFUL LINKS Recycied materils + Trash
Facility Notes ]
Bureau Contacts Ssisslout:

Your undiverted municip al $old waste has resuted in approdmately 040161 MT COZe (metic fonne carbon digude

2011 Solid Waste Data aguivalent) in greenhouse gas emissions.

© “Greenhouse Gas Emissions amount = short lons of undiverted municipal waste x 0,730 2 NTCOZefshor ton

Denartment YWaste Diversion Goak: 50% or more by FY 2015
Your facility has met o1 sxcosded the Dopar tment’s goal
Guidance on how b enhance your Waste Diversion and Recycking Program

Stats Wasto Diversion Goak 50.00 %."
Yom huave et of exceeded your Siate’s waste dversion goal.

* Wote: Rucant shangas b Slate miste divartion goals sy a4l ba & e hase

ang Hazardous Chemicals Management 41

PFlease procend 10 Sobd Waste Man agement Texc

Once you have entered and saved all of your data for Recycling, you will see this screen.
Note that there are additional links providing information on how to enhance your waste
diversion and recycling program and about recycling goals. Click on the link at the bottom
to “Proceed to Solid Waste Management: Toxics and Hazardous Chemicals Management.”



Data Entry Guidelines

Facilities must provide data for undiverted waste in addition to what was
recycled for both municipal solid waste and construction and demolition
(C&D waste).

Undiverted waste is the amount that went to the landfill and/or waste-to-
energy (WTE) facilities.

Facilities reporting only amounts recycled and a 100% recycling rate
will be asked to explain why they have such a high recycling rate.

Report amounts of biomass/wood chips burned onsite for heat or
electricity as WTE if wood would have otherwise gone to a landfill

Even if waste disposal is free, the amount disposed of should be
reported.

Please do not double count. If a quantity of a commodity is reported as
recycled, that quantity should not be included in the landfill or waste-to-
energy amounts.
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Toxics And Hazardous

Chemicals Management
A kﬂ!@; -n_.hp V.

Home FacllityData Reports Bureau ReportGenerator Admin Help Logout

Home » Facsty Data » Sobd Waste Management »

SOLID WASTE MANAGEMENT ~ Facility: OEPC Albuquerque Regional Office

I Preventon . .
_SOIUWaste S Toxics And Hazardous Chemicals Management
Sy iy | Mot You rmst click om “SAVE® below or your data will be lost,
‘Waste Disposal 1) Briefly describe what your faciity has done to reduce the purchase of todc and hazardous chemicals
e D0 Not report quantiative Iformation (volume of dollars) on chemicals of chemical-containing products.
Toodts and Hazardous purchased or reduced
Chemicals Management
S T—— have a plan 1o repla ¥ Wilh hon-mercury allematives
Forward Solid Waste Data
Print Solid Waste Data
USEFUL LINKS
Facility Notes
Bureau Contacts

2011 Solid Waste Data
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This is the page to enter information on your facility’s efforts to reduce the purchase, use
and disposal of toxic and hazardous chemicals. Enter your narrative information and click
“SAVE.



PRINT REPORT
FORWARD DATA

Renu Chaudhry
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Printing your reports

* Print a copy of each report before you
finalize!
— Hard copy can be circulated for review and
approval within your facility prior to finalizing
— Click on “Print Solid Waste Data”

— Navigate to web browser and select print
function there

45
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When you are

done entering

data, you may
print your

report here.

Printing your reports

Home » Faciity Dats » Solkd Waste Management »

Facility: OEPC Albuquerque Regional Office
SOLID WASTE MANAGEMENT

Summary: Solid Waste Management -

ek on the PRINT bufton to prind th report

A. Solid Waste Prevention
1) Isyour facilty in lexsed space?
1a) s your facilty in leased space within a multi-tenant buliding?
2)  Does your facilly have an active office products recycing program?
3) Does your faciity have housing units?
3a) ¥ appiicable, how mamy residential housing units operated by your facility have access to an active

househokd products recycing program?

units of total units
The atsbaee wall caboulate B e parcentge based o the nomd ar of units you provide hare

4)  Did your faciity institute new, substantially improved, or updated non-hazardous Solid waste prevenbion
[practices in FY 20127

It Yes, please explain (255 characters max):

5) Does your faciity compost any of its waste (either onsite or offsite)?

46

It yes, select the type of compoesting.
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Forward Data

SUSTAINABLE PRACTICES DATABASE

Facility Data Reports Bureau Report Generator Admin Help Logout

Home » Facility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT Facility: OEPC Albugquerque Regional Office

| Sold Rre | Toxics And Hazardous Chemicals Management

| Recytling | The Toxics And Hazardous Chemicals Management data has been saved for this facility,

Click here for Waste Disposal

your report to Toxics and Hazardous

be forwarded Chemicals Management
to the Forward Solid Waste Data

] Please proceed 1o Solid Waste Management F orward Solid Waste Data

FEQiﬂnaL Print Solid Waste Data
state or area USEFUL LINKS
office |

Bureau Contacts ]

| 2011 Solid Waste Data l

Facilty Notes |

47

When you have completed entering the data for Solid Waste Management or Green
Purchasing, you must “Forward Solid Waste Data” before it is sent to the Central Office for

approval.



System Checks

Facility: District Office

Forward Solid Waste Management Data

Vour daia is compieie bui

The total recycled amount for your facility is at least 10 bmes greater than the FY 2011 recycled amount
The total trash amount for your facilily is at least 10 imes greater than the FY 2011 irash amount

The total recycled amount for your facility is 3t least 1000 tons more than FY 2011 recycled amount

Pleass verily the data you've enlised andiod prowide an explanalion hare

Please select reason's:

™ Facilty Expanced Recycling/Composting

I~ Facity Started Hew Recycling/Composting

( Facilty had a singular event that increased/decreased quanibes
™ Disposal increaseidecrease was due to changes in Visitaon
™ Usage or Temporary Facilty Clasure

F Improved Tracking

™ Weighing Trash instead of Volume Estimates

™ Asded New Materials 1o Recycling Program

Please explain:

ore accurate tracking

* The system checks for data completeness and
consistency when you click on “Forward Solid
Waste Data”

+ Errors iike the one shown here appear when:

» Recycling is 10 times or greater than last
year's amount

*Recycling is less than 10% of last year's
amount

*Greater than 50 ton variation in trash or
recycled amount if total waste is 100 tons or
less.

* Non-diverted waste is 10 times or greater
than last year’s amount

* Non-diverted waste is 10% or less of last
year's amount

+Greater than 1,000 ton variation in trash or
recycled amount

+ Recycling rate is 100%
* You must either correct your data or provide an

explanation when you receive this error.

48

48



System Checks

s Bureau Report Generator Admin  Help Logout . These erro rS Shew
agernent »
that we have not
Facility: OEPC Albuquerque Regional Office ente red al | Of the
Forward 5olid Waste Management Data req u Ired data'
‘Your data on Solid Waste Management Data is not complete yet. Please enter all the data and then finalize
it. Please compiete the following data . We must
The d h /Solid is lete.
on new, improved, or updated solid waste prevention practices (Solid com plete th ese

Waste Prevention #4).
Expi on Req

for Waste Red: Plans.(Solid Waste Prevention #7) e ntries p riO r tO
forwarding our
data.
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If your data are not complete when they are finalized, a screen will appear to tell you what
information is missing and must be completed before it can be finalized. You must enter
this data before it can be submitted to your Central Office.
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Forward Data

s Bureau Report Generator Admin Help Logout

nagement »

Facility: OEPC Albuquerque Regional Office

Forward Solid Waste Management Data
= Afteryou click on "Continue™ your regional or central office will be notified that your facility data are available for review.
* Afteryour data have been reviewed al the regional or central office level, your data will be forwarded 1o your bureau

headquarters for review and inclusion in your bureau’s Sustainable Practices Report

If all the data for Solid Waste has been added / edited completely, check the box to forward the facility data
for regional approval

) ™ Forward the Solid Waste facility data for approval.

CONTINUE

50

If you have completed all of the information required by the Sustainable Practices
Database, you will see this screen when you click on “Finalize Data”. Click on the box to
forward your data, and then click on “Continue” for your data to be forwarded to the
Central Office for approval. Your Central Office manager will receive an email notifying
them that your report has been finalized.

Once you have finalized your data, the facility user will not be able to edit it. If you discover
an error, contact your Central Office to return the data to you so that you can make the
change. If data is returned and sent back to you, you must finalize the report after you
make your changes so that the Central Office will be notified you have made your changes.

You will receive an email if your Central Office returns your report to you for changes.
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Central Office Data Review

an_=_

A s
Tnis

tage:

- If edits or clarification are I—— Facility User enters data
necessary the Central -

Office program reviewer — _ _ ﬁ
sends report back to [ Facility User finalizes data and forwards it for review

Facility User.

- Then the Facility User
makes changes and re-
finalizes the data, sending
the report back to the
Central Office.

-If no changes are needed,
the Central Office User can
forward data to the Bureau
HQ User
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Once the Central office receives the data, the Central Office may decide that there is a
problem with the facility data that must be corrected before it can be forwarded on to the
bureau or office HQ level for approval. If there is a problem with facility data, the Central
Office User may send the data back to the facility user for correction by “Unapproving” or
“Returning” it.

If the Central Office sees that the data for its facilities are ready to be forwarded on to the
Bureau HQ level, the Central User may then forward the data on. For more information on
this process, please see the Powerpoint presentation for Central Office Users.
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Questions can be emailed to SPReport@ios.doi.gov

QUESTIONS? WRAP-UP
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